Creating and editing tracks in OkMap 10/11/2021

This guide assumes that you have already installed OkMap Desktop [see Installing and setting up OkMap]
and know how to load a map and a pre-recorded track [see Looking at tracks in OkMap ]

Finding your way around OMap
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In OkMap you can see a permanently available tab labelled and five others Home - View -
Management - Navigation - Utilities. Initially, and for most of the time, you will be in the Home tab.

In the top row there are 12 icons which allow quick acces to certain operations.

T AN R R AR -

Hovering over any of these gives a written description of its purpose. %

Load waypoints, routes, tracks (multi)

In practice there are only five of the twelve which are used E’; % ﬁ —
with any frequency. Clicking on the icon at the end will allow &

you to show only these five. m

Untick all options except for

Load map Savewaypoints, routes, tracks Preferences ‘
Load waypoints, routes, tracks [multr) Lizttracks

Before trying to make changes to a full recorded track work your way through the simple steps below. This
will make it easier to understand the more complex example which follows.

Keyboard shortcuts
There are a number of keyboard shortcuts, using the Ctrl and Alt keys, available in OkMap.
In use press and hold down the Ctrl (or Alt) key and then press the second key before releasing both.

Creating a new track

Home View Management Havigation Utilities
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https://www.theramblers.ie/wp-content/uploads/2016/03/GPXLib-Installing-and-setting-up-OkMap.pdf
https://www.theramblers.ie/wp-content/uploads/2015/12/GPXLib-Looking-at-tracks-in-OkMap.pdf

With a map loaded and visible going to the New track point icon 2’! and clicking will change themouse-
pointer from the usual arrow to a cross-hairs.

Clicking at a point on the map causes a blue dot to appear with the number 1 beside it. Clicking at another
point makes a second blue dot appear joined to the first. The 1 moves to near this second point. Doing this
a few more times will create a track.

Pressing Alt-S or clicking on Slﬁm will end the creation of a track and change the cursor back to an arrow.
objects

This track, named 1, will still be selected i.e the trackpoints will be shown as blue dots.

. " . . .
Clickngon ;. will open the File manager window on the right of the screen.
manager
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Using File manager

Clicking on the + sign beside Waypoints, tracks, routes in the Waypoints, tracks, routes

menu will show that there is a New file containing one track = e b <Newfile> (Wit 0- Rte D- Trk 1)
and no waypoints or routes.

EI _ Waypoints, tracks, routes

- Topoyms | fiffl  Select waypoints, routes, tracks file
..... Photos . .
Right-clicking on the file will access a e List indexed file % Merge waypoints, routes, tracks file
drop-down menu of options and clicking o OkMap databz %.  Split routes, tracks
on
List tracks S  List waypoints
|%. List tracks N ||
will open the Tracks list window : nL
-% List routes
% Save waypoints, routes, tracks
% Close waypoints, routes, tracks
Tracks list B
Fiters [Name | |
Comment v | |
o Name . Selected Comment Description Source Link

0 gﬁg::ﬁ . Point number Name Selected Comment Description Source Link: Symbal
o | 0
2 1 2 O
i 3 [
4 |1 4 [
* O
< >
[ Auto locate point
0K || Cacel | Appy | Refresh

Context menu available (mouse right click)

The Name of the track, , can be changed - OkMap has a limit of 30 characters for the name.

o MName & Selected

3 0of 15



oK

Cancel

Apply

Refresh

Clicking on Apply followed by OK at the bottom of the window will show this change.

. . . . . Select all
Returning to the Tracks list,right-clicking on the Name and s
. « s . . . . f O Unselect all N
selecting Statistics will give the information about the number clect hiahliahted =
. . | v elect highlighte:
of Segments, Points and the Distance traveled (km) o o —
b 3 nselect hightlighted |,
| €
. . . =] Statistics I
In this case there is only one segment but a recorded track in P Y— £
which the recording has been paused at intervals may consist ~ &) Export data
of several segments. | P |er——
Track statistics n
View ®) Vertical () Horizontal Order by (@) Measure unit ) Twpe
0 Track name Type Mame Value
| 3R Crow flies-Oldbridge-Brown Track Description
2 Commenrt
3 Seaments 1
4 Paints 4
5 Distances Distance traveled (km) h76
6 Distance traveled flat fcm)

. . Track graphs a
SeIGCtlng Graphs InStead Of Crow flies-Oldbridge-Brown (x => km, y => km) X/Y-Bais
Statistics will usually show a graph .
of the elevation recorded at each Y

. 7
Options
pOI nt ' [] Cardinal spiine
5 [ Smoathing 5w
In this case no elevation has been Doy
recorded. :
[ Show segments
A Show waypaints
: A Show toponyms
- - g [ Show points
= Statistics 3 £ s
[ Auto locate point
=" Graphs .
] E : x W
+#|  Export data .
1
&4 Set DEM altitude e
o o z 3 5 3 7 Context menu available imouse right

click])



This can be seen by scrolling from left to right as shown below so that for each point its Coordinates,
Elevation and the Date time of recording are shown.

ﬁ gﬁg;m 4 Point number Coordinates {I?ne)vation Date time Mag. var. Geoid height Fix
1 1 O 15643 01629 w
2 1 2 0 13253 01346 b
3 |1 3 0 12528 03332 hd
£ 1 4 0 14228 03516 hd
- b
£ ; >
[ Auto locate point
| oK | Camcel [ Acply | Refresh |

Context menu available (mouse right click)

Digital Elevation Model [DEM] files
DEM files store the elevations of points on the Earth's surface and can be downloaded from a various web

sites.
Home View Mavigation Utilities
In the Management tab of OkMa .
I. ) g . p. =2 @ % MED pararneters E‘? List themes
clicking on Download DEM files will - £t Map arid
suggest a file to be downloaded H'ﬂp . f!"lnéflp ! Map descript ’:'f‘;p Change theme
. . . . 1 InTa = = CrIpTan N
which will contain the elevations of " : Map managhment
points on the map displayed.
&3 Download DEM files — O =
ﬁ Path File Size Status Download %
b 1 | fetmsversionZ_1/SRTM3/Eurasia N5IW007 hat 796.203 | Mot available locally -

If the Status is Not available locally clicking on Download at the bottom of the window will start the
process. It may take a minute or two.

Context menu available (mouse right click) Cancel || Download ’\J Close |

Once the download is complete and the Tracks list window is = Statistics
on view again then right-clicking on the Name allows ~"  Graphs
Set DEM altitude to be selected. B Export dats
This will then fill the Elevation column as shown below. 4 Set DEM altitude
|
s Gef DEN alttude for selected
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0 Segment Point number Coordinates

Elevation

number {mi)
= | O 15643 01629 v [2290
2 |1 2 0 13258 01846 ~ |596.0
3|1 3 0 12528 03332 ~ [518.0
4 (1 4 0 14228 03516 v [395.0
] W
Tack graphs
Grow fies-Oldbridge-Brown (x => km, y => m)
Selecting the Graphs option
will now show a proper
elevation graph. - =
VA S
// \\\
/ AN

Saving and closing the track

Right-clicking on the file in File manager and selecting
Save waypoints, routes, tracks will bring up a standard
File save window.

Typing in a name for the file e.g.
Oldbridge-Scarr-Kanturk-Brown.gpx

Note: this will be the name for the file which contains the
track called Crow flies-Oldbridge-Brown
This file could contain further tracks.

T3 GPX data
and clicking OK on the next window ' '
without typing anything into the Name Name
and Description boxes will save the file. Description

Cancel

Waypoints, tracks, routes

Ml <New file> (Wot 0 - Rte 0 - Tric 1)

Diate time

XY -Pxig
b QIO stancs] v
v

Options

[ Cardinal spline
] Smoothing 5w
[ Ignore GPS emors
Show grd

Show zero line
[ Show DEM data
[] Show segments
Show waypoints
Show toporyms
[] Show poirts

Auto info

[ Auto locate point

Zoom
x ¥
v ¥

Move curser on a graph point to
display its properties

Context menu available (mouse right

Toponyms i/l Select waypoints, routes, tracks file
Phatos I
List indexe] 4  Merge waypoints, routes, tracks file
OlkMap da| .
T:": Split routes, tracks
By List waypoints
?1. List tracks
T4 Listroutes
‘&. Save waypoints, routes, tracks P
‘“i Close waypoints, routes, tracks
— X
[ |
oK

Having saved the file then selecting Close waypoints, routes, tracks will finish the process.
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Editing tracks

Selecting and deselecting a track
Moving the mouse-pointer onto a
track will change it from an arrow to ; :
a hand and the track name is shown. /! /i/ ;

Clicking will then select the track and f
show the trackpoints as dots.

Clicking at any point on the map
which is not on the track will
deselect the track — the dots
disappear.

Two or more tracks can be selected by holding down the Ctrl key while selecting the tracks.

Modifying a track — renaming it and changing its colour

Right-clicking on a track brings up a context e R e
p by Select k
menu. 4
o = Info 3
Selecting 4 7 Modify »
Modify > track: Track one | £+ Move *
will bring up a window in which you can change | Hide 3
various properties including its Name. W Delete .
4
- S
— ] Track Center
Mame ’m ﬂl Calor > | & I
Comment Line width s
You can also change the track Deacrption Line pattem v

e e T
e I

Misible

Color — tored, say.

Proximity circle colar - | K

Label visible Proximity circle opacity

Ak

Posit. visible Proximity circle width

Proximity circle visible Band color v | K

Band visble Band opacity

v [y
=

Bearing line visible Band width

Label font - .(\ Bearing line color v | K

Bearing line width w

It is important to click first on Apply and then OK to effect any changes made.
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Creating a second track.
Make sure that the first track is deselected - i.e the trackpoints are not shown — by clicking anywhere not
on the track. If this is not done any new trackpoint will be added to the end of the first track.

Change the cursor back to a cross hairs by going to the New track point icon %

Click on the starting point for your new track and create a separate new track whose name, by default, will
again be 1 [if you hadn’t renamed the first track the default second track would be 2] .

Finishing with Alt-S or by clicking on 32, the track can then be renamed and its colour changed.
objects

The result might look like this - perhaps Track one
is being followed by a crow while Track two is
being followed by a group of hikers.

TNHILARELS ST

- $ ¥ = |
PR TL ™ - T O e

Hiding and unhiding tracks

. . . L 7 Modi
Selecting a track and right clicking on it brings up a i s .
<+ M
context menu. Go to o Ml
il Hide
Hide > track: Track one | 7% Dele=
f Generate
click and it will be hidden.
bl - W' Routes
Visit link Tiacke
. .. . Download GPX data
Right-clicking anywhere on the screen which
) . Navigat Toponyms
is not part of a track brings up the context menu. i i
Other functions Photos
. s Map icons
GOIng to . pordinates ' | Map comments
All objects > Unhide all > Tracks {#% Routing N —
|l Selected objects 3 oy Multipoints
and clicking will reveal all previously hidden tracks. ||,j All objects >|] <A Moveal » Palylines
[ Select all Ctrl+E " Unhideall > :Clygcn:
1es

[l Deselectall Ctrl+D )<\ Deleteall  »

Vectorial data
o s
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Selecting trackpoints

Select the track to show the trackpoints as dots.

A single trackpoint can be selected by moving the arrow until a small window pops
up with details about the point and then clicking on the point.

Track: Track two
Segment: 1
Track point: 11

. . . 0 14647 02413
A black square is drawn around it to show it &% Fle 384 m

has been selected.

e—r P

You can also just click on the point without waiting for the window to pop up.

To select a group of trackpoints hold down the Shift key and use the mouse-
pointer to draw a box around the required points.

Alternatively select the points one by one while holding down the Ctrl key.

Deleting trackpoints or tracks . RN N

-

Right click on the selected trackpoint il RN
and select |IX Delete 3 track point: Track two 112
Delete > track point: <...> {5 Generate v track: Track two
| e pawmmee o

Note: there is also the option to delete the complete track.

To delete a selected group of trackpoints right-click on one of them and v Ym0
select 0 Alcbjects > |2 Moveseeed G

(B Selectall CrlsE f,Hide selected Tpuiis

S8 Rout AL ey
;
;
.
;

Photos

Selected objects > Delete selected > Track points U oo oo [N o

Undoing an editing action
Before continuing it is important to know how to try to recover from a mistake.
First switch from the Home tab to the Management tab

Home View Management Mavigation Utilities

and then click on Undo GPX changes which  ypoints "2& Colorall tracks | 3§, Undo GR changes o

can be found to the right. . b
Undo GPX changes I'Sli'rﬂ

GFX

Return to the Home tab.
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Moving trackpoints or tracks - locking and unlocking objects

m View Management Havigation Utilities
=2 Full screen + .* | F o R W
™ O @TI’LI‘I"EF'“ b % Vo f,{; .‘.f -7 ,J_'I’J\f el é% T =| Awto info l.
File Zoom N Select Lock | = . Coording
manager vn S Magnifying glass | objects % % * % 61? ‘i'? & é%- objects | ™ Refresh ! place
Show Tools Mode

Initially objects on the map, such as trackpoints and tracks, are locked to the map. To confirm this go to the
Home tab and check that the Lock objects icon has a pale blue [= selected] background

By holding down the left-button the mouse-pointer changes to a hand which can move the map ‘{Ij
and the objects together up/down or left/right.

i}
Changing the pale blue background to white [= unselected] by clicking on the Lock objects icon Lf_k will
unlock all objects on the map objects

Pressing Alt - L will do the same. Repeating either process will toggle between the locked/unlocked states.

Now, if the left-button is held down, when the mouse-pointer is on a trackpoint it changes to a *‘:"
move cursor and the point can then be moved into a new position. d

Similarly if the mouse-pointer is on a selected track, with all the trackpoints showing, the whole track can
be moved.

This can easily happen inadvertently.

In this case it's probably best not to try to move the track back with the mouse-pointer. It can be tricky to
find the original position. Instead just follow the above instructions for Undoing an editing action to undo
the last action.

Note: While objects are locked on the map the map itself together with all objects can still be moved
provided the mouse-pointer is not on a track or a trackpoint.

Editing using the Tracks list window

Filters Mame

LIRS

Comment

€ | Name Selected Comment Description Source Link
1 | Track one (]
2 o
- |
<
€ | Scopent Point number Coordinates Eevation Name Selected Comment =
» + R O 13205 02431 ~[4350 ]
2 |1 2 0 13278 02498 ~ [466.0 O
3 |1 3 O 13389 02528 ~ |4530 O
a4 |1 a O 12435 02565 ~ 4430 O
5 |1 5 O 13512 02608 ~[4310 ]

[ Auto locate paint

oK Cancel Apply Refresh
Context menu available (mouse right click)
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O Name Selected Comment Description Source Link

Track one

] O
 » e N N B
5 O

The upper half of this window shows a list of all the tracks created. In this case there are two i.e Track one
and Track two

A track can be deleted if its row is highlighted, as shown above, and the Delete key on the computer is
pressed.

ﬂ ESEE::" Point number Coordinates [I?ne}vation Mame Selected Comment "
b 1 O 13205 02431 v 4890 =
2 1 2 O 13278 02498 v | 466.0 O
3 |1 3 O 13389 02528 v 4530 O
4 1 4 O 13485 02565 v 4430 O
5 |1 5 O 13612 02608 v (4310 O
< - - A e L P — 5 N
L] Aute locate point oK T Aoply T

Context menu available (mouse right click)

The lower half of this window shows a list of all the trackpoints of the track selected in the upper half.
Again any point or points can be deleted if the rows concerned are highlighted and the Delete key on the
computer is pressed.

B L Lt LRl

Statistics
Right-clicking on a track Name in the upper window brings up a ARt

context window. Graphs
Set DEM altitude
The options Statistics, Graphs and Set DEM altitude have been Set DEM altitude for selected

considered above.
Set travel time

Set travel time for selected

Simplify track
. . Duplicate track
There are five more commonly used options.
Invert track
Merge segrnents

Add to Join track

Nefault arid lavnnt

Joining two tracks
Consider the two tracks - Track one for the crow and Track Two for the group of hikers - shown on P.8

If the crow decides to join the hikers we can combine these into a single track as follows.

Right-click on Track one to bring up the context menu and select Add to Join track . You will see a new track
called JOIN in the window. Click on Apply.

Now right-click on Track two select Add to Join track and click on Apply.
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You will now have three tracks - Track one, Track two and (overlapping these two) JOIN.
In the Tracks list window delete Track one and Track two (as described above) leaving the single track JOIN.

If you look at the lower half of the Tracks list window you will see the track JOIN consists of two separate
segments on the map.

Merging segments

Right clicking on JOIN, selecting Merge segments and clicking on Apply will create a new track called
U.JOIN.

This will have only one segment with the last point of the first segment connected to the first point of the
second segment.

JOIN can now be deleted and U.JOIN can be renamed appropriately, say Oldbridge to Brown.

[Be careful of the order in which you “lay down” the JOIN track. Merging will connect the end point of the
first track “laid down” to the start of the second “laid down”. If they are “laid down” in the wrong order it
will soon be apparent.]

Inverting and copying track

The Oldbridge to Brown track created above is the track followed by the crow from Oldbridge to Brown
Mountain. Right-clicking and selecting Invert track will create a track called I.Oldbridge to Brown which is
the same as Oldbridge to Brown but in reverse.

You will probably want to rename it as Brown to Oldbridge

Selecting Duplicate track instead of Invert track will create C.Oldbridge to Brown, a copy of the track.

Simplifying a track

A recorded track may contain over a thousand points. To make editing easier select Simplify track which
creates S.Oldbridge to Brown, a file with fewer points. The number of points can be set under Preferences
[ click on ﬁ ] in the Tracks tab

Moving the Coordinates and Elevations columns

Maximize the Tracks list window so that it is as wide as possible.

The first two columns, Segment number and Point number, are fixed.

If the Coordinates column is not visible use the scroll bar at the bottom of the window to make it so. Move
the cursor to the top of the column, press and hold down the left mouse button and drag the column to its
new position.

@ .fm::ﬁ Comment Description Source Link Symbol Type [ESVE

Ty " R 0 15294 s oy
2 v| 0 15481 02366 v 2180
30 vl 0 15506 02457 v 280
41 v| 0 1453 03523 v 250
5 1 vl 0 15397 W21 v

< j ‘ ; l j ; : ‘ 3
cDmA::Dr:i:D:Tanaue (mouse right click) OK o i i

Release the mouse button and the column will now be shown in its new position.

Repeat for the Elevation column then click on Apply.

Now in future these two columns will appear in these positions whenever the Tracks list is opened.
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An example

When editing a GPX file to modify a track you should always work on copy of the file leaving the original
unchanged.

It's a good idea to create a folder called something like Temp files in your GPX files folder.

Copy the original file to be edited, Knockree to Maulin to Knockree.gpx, say, into this folder and then
rename it as Knockree to Maulin to Knockree- new.gpx

The original will be unchanged and you can now work on this copy.

When you have finished and are completely satisfied save the final version into the GPX files folder not the
Temp files folder which you can delete.

In this example part of a track from Knockree to Crone = 8. &“%;w}.gﬁ’ & T
. . = “;_".. o racken - ...r——/\ “(Jr}onz;‘sldajlli
and over Maulin, is shown. NN 7T iy

The Name of this track is Knockree — Maulin,

Suppose that you want to go around Maulin instead of
over it.

By zooming in and hovering over the points you
can determine that the secton to be replaced is
between Track point 107 and Track point 150.

Eled47m
2/1/2015 1:28:25 PM ¥

Zf'VZI)TiTl:}T:DT PM

N WL J- <

The first job is to create two new tracks, one from the start at Knockree to point 107 where the ascent of
Maulin starts and the other from point 150 back to the finish at Knockree.

Using the File manager create two duplicates of the track Knockree — Maulin and rename ones start and
the other as finish. Delete the track Knockree — Maulin
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0 MName A Selected Comment Description
1| finish

b 2

. ]

<

ﬁ ﬁ,j?—,rg:ﬂ 4 Point number Coordinates Ee}uaﬂon MName

106 |1 106 O 19263 12619 ~ 14320

107 |1 107 O 15306 12710 ~ 1443.0

108 0 19270 12751

109
110
111

O 15251 12764

O 151595 12785

O 15185 12734

With the start track selected highlight the points from 108 to the end by first highlighting row 108 and,
holding down the Shift key, scroll down to the end before releasing it.

Now delete these points by pressing the Delete key on the computer. Click on Apply.

In a similar manner, with the finish track selected delete all the points from 1 to 149 and click on Apply.

Click on OK to see the start and finish tracks

Here the start track has been selected and all
its trackpoints are shown.

Now it's necesaary to extend the start track
to join the finish track along the chosen route
around Maulin.

Zoom in, making sure the start track is still
selected so that any new pont added will be
from the end of the start track.

Click on the new track point icon E& and
start adding points between the end of start
and the beginning of finish.
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In the File manager add start to JOIN followed by finish. Then delete both start and finish and merge the
two segments of JOIN before setting DEM altitudes. Finally rename it and save the file.

Some other options in File manager

Combining two or more GPX files

If you have two tracks saved in two different GPX files File manager 2 x
you might want to combine them into one file before T e e
doing any ed|t|ng — ; Waypoints, tracks, routes
E Topon}:l'l'.l; == W Select waypoints, routes, tracks file
Load the first file, Test track one.gpx, say. [w et % Merge waypoints, routes, trocksfle
= prg _ . .
In File manager right click on it and choose s+ Datums | ¢ Listwaypoints
«%  List routes
Merge waypoints, routes, tracks file T4 Listtracks
“% Save waypoints, routes, tracks
This will open a file selector box and you can select the ] Close waypoinks. foutes. Iracks

file to merge, Test track two.gpx, say.

Save the resultant file with a new name, Test two tracks .gpx, say.

Dividing a track into two separate tracks

On Test track by selecting trackpoint 100, say, right-clicking, @ | o ot rumber __ Coordinaics
. . . . . . - q [#]  Selectall
choosing Divide track and clicking on Apply you will divide | o, (o e
Test track into two tracks. ¥ i Select ighlighted
10 1t Unselect hightlighted 19295 12359
. . 0 ey Copy coordinates 23
Test track now contains all the trackpoints from 1 to 100 | ————— "0 1797
< 4 ind on cpened mMaps
dabh,  Set DEM altitude
A second track will have been created, called N.Test track, that | &K et DEM atituce for selected
contains all the rest of the points which will have been 8, New segment
renumbered starting from 1. e N
= | #~  Default grid layout

Deleting points which are off the map
File manager is useful when you forget to stop recording your track and, as a result, have recorded your
drive back too. Typically this mean you want to delete a lot of points which are off the map you are using.

In this case find and make a note of the number of the point where your hike ended - you'll probably have
to zoom in a lot to see it.

Now use File manager to select all the rows from this point to the end and delete them.
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